Table Of Contents

Administrating Engineering Base in a Network ..........1
  Server Hardware Recommendations .......................... 2
  Administrating User Accounts ................................. 3
  Firewalls .......................................................................... 4
  Local Security Policy Settings ........................................ 7
  Component Services ........................................................ 12
  Remote Access .................................................................. 12

Floating Licenses .............................................................. 13
  Installation HASP License Manager ............................ 14
  Installation HASP Device Driver .................................... 15
  Updating a NetHASP Dongle ......................................... 16
  Using the Nethasp.ini file ................................................. 17

Optimizing Performance ................................................... 19
  Optimizing Windows XP for better Performance ............. 19
  Optimizing Microsoft Office Visio for better Performance ... 20
  Optimizing Microsoft SQL Server for better Performance ... 21
  Optimizing Engineering Base for better Performance ....... 22

Windows Registry Settings ................................................ 23
  Accelerate Preview .......................................................... 25
  Adding an SQL Server ..................................................... 25
  Changing the name of the default Application Server ........ 26
  Changing the name of the default SQL Server ................. 27
Engineering Base Administrator's Guide

Changing the name of the default database ............................................. 28
Disabling reopen sheets ....................................................................... 29
Disabling the start screen .................................................................... 29
Setting the picture for the start screen ............................................... 30
Setting the File for the Intro ............................................................... 30
Setting the Folder for System Files ..................................................... 31
Setting the Number of Undo Levels .................................................... 32
Setting the default Unit ....................................................................... 33
Setting the Font ................................................................................... 33
Setting the Width for the first Column in the Open Dialog ............... 34
1 Administrating Engineering Base in a Network

Engineering Base has a three-tier client/server architecture. The application is structured into three levels: User interface, business logic, and database. In a typical network environment, the user interface is installed on the client computer. The business logic and the database is installed on the server computer.

Topics in this chapter:
- Administrating User Accounts
- Firewalls
- Security Settings
- Component Services
- Remote Access
Server Hardware Recommendations

The following recommendations are based on our experience from the test lab and from our customers and vary depending on the way how data is organized and used.

<table>
<thead>
<tr>
<th>Number of users</th>
<th>Processor</th>
<th>Operating System</th>
<th>Memory</th>
<th>Hard Drive</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 - 5</td>
<td>Intel® Pentium® D processor 2.8GHz, 2x2MB L2 Cache, 800 MHz FSB (or comparable)</td>
<td>Windows 2003 Server</td>
<td>4GB DDR2 SDRAM 533MHz</td>
<td>2 x 80GB 7,200rpm 3.5&quot; SATA (1 drive for the SQL-Server database file, 1 drive for the SQL-Server log file)</td>
</tr>
<tr>
<td>6 - 20</td>
<td>Dual Core Xeon®, 4MB Cache, 3.00GHz, 1333MHz FSB (or comparable)</td>
<td>Windows 2003 Server Enterprise Edition</td>
<td>8GB FB 533MHz (8x1GB dual rank DIMMs)</td>
<td>2 x 80GB 7,200rpm 3.5&quot; SATA (1 drive for the SQL-Server database file, 1 drive for the SQL-Server log file)</td>
</tr>
<tr>
<td>20 - 50</td>
<td>Dual Core, 3.4GHz, 16MB L3 Cache, 800MHz FSB (or comparable)</td>
<td>Windows 2003 Server Enterprise Edition 64 Bit</td>
<td>32GB DDR2 SDRAM (16X2GB 40MHz dual rank DIMMs)</td>
<td>2 x 146GB, SAS, 3.5-inch, 10,000 rpm (1 drive for the SQL-Server database file, 1 drive for the SQL-Server log file)</td>
</tr>
</tbody>
</table>

Administrating User Accounts

To access the Engineering Base database, every user must be a member of the local Engineering Base group on the server computer. The Engineering Base group is automatically created during the installation. The installation also creates a shared folder with the name Engineering Base Transfer with full access for all members of the Engineering Base group.

• If you are working in a Domain
  Add the users to the local Engineering Base group on the server computer.

• If you are working in a Windows Workgroup
  Create the remote users with identical login names and passwords on the server computer. Add these users to the local Engineering Base group on the server computer.
Firewalls

If you are using a firewall, exceptions for SQL Server and Engineering Base have to be defined on the server computer and port TCP135 must be opened on the server and on the client computers.

The following changes to the Windows Firewall are required in order to enable access to the Engineering Base Server. During the installation of Engineering Base, these changes are made automatically, however due to updates or patches to the operating system, these changes might be reverted.

If you are using a different firewall, you need to make the changes accordingly. Administrator rights are required to make the changes.

To define the exceptions

1. From the Windows Control Panel, start Windows Firewall.
   
   This opens the Windows Firewall dialog.
2. On the **Exceptions** tab, click **Add Program**.
   This opens the **Add a Program** dialog.

3. Click **Browse** to select `C:\Program Files\Aucotec\Engineering Base 30\Microsoft SQL Server\80\MSSQL$ENGINEERING_BASE\Binn\sqlservr.exe`, then click **Open**.

4. Click **Change Scope** if you want to specify the set of computers where you want to run Engineering Base and click **OK**.

5. Click **OK** to close the **Add a Program** dialog.

6. Repeat step 3 to 5 to add the following programs to the Exceptions:
Engineering Base Administrator’s Guide

7. In the **Windows Firewall** dialog, click **Add Port**.
   
   This opens the **Add a Port** dialog.

8. In the **Name** box, type **TCP135**.

9. In the **Port number** box, type **135**.

10. Click **TCP**.

11. Click **Change Scope** if you want to specify the set of computers where you want to run Engineering Base and click **OK**.

12. Click **OK** to close the **Add a Port** dialog.

13. Click **OK** again to close the **Windows Firewall** dialog.
Local Security Policy Settings

The following changes to the Local Security Policy settings are required in order to enable remote access to the Engineering Base server. Administrator rights are required to make these changes.

1. From the Windows Control Panel, start Administrative Tools.
2. Open Local Security Policy.
3. In Security Settings, expand Local Policies, then select Security Options.

5. On the shortcut menu, click Properties.

This opens the DCOM: Machine Launch Restrictions in Security Descriptor Definition Language (SDDL) syntax dialog.
Engineering Base Administrator's Guide

6. Click **Edit Security**.
   
   This opens the **Launch Permission** dialog.

7. Add the local Engineering Base group with **Remote Launch** and **Remote Activation** permissions and click **OK**.
8. Click OK to close the Launch Permission dialog.
9. Click OK again to close the DCOM: Machine Launch Restrictions in Security Descriptor Definition Language (SDDL) syntax dialog.
10. Close the Local Security Settings window.
Engineering Base Administrator’s Guide

The following Security Settings are required if you are using computers running Windows XP in a Windows Workgroup.

1. From the Windows Control Panel, start Administrative Tools.
2. Open Local Security Policy.
3. In Security Settings, expand Local Policies, then select Security Options.
4. In the right pane, select Network Access: Sharing and security model for local accounts.

5. On the shortcut menu, click Properties.

This opens the Network Access: Sharing and security model for local accounts dialog.

6. Select Classic - local users authenticate as themselves.
7. Click **OK**.
8. Close the **Local Security Settings** window.
Component Services

With Microsoft Windows Server 2003 Service Pack 1 (SP1), the COM permissions restrict remote calls that are not authenticated. By default, only members of the Administrators group have the Remote Activation permission and the Launch permissions. This prevents user accounts that do not belong to the Administrators group from starting COM components.

To resolve the permissions issue
1. From the Windows Control Panel, open Administrative Tools.
2. Open Component Services.
3. Expand Component Services, then Computers.
4. Select My Computer.
5. On the shortcut menu, click Properties.
   This opens the My Computer Properties dialog.
6. On the COM Security tab, click Edit Limits in the Launch and Activation Permissions area or in the Remote Activation area.
7. Click the Engineering Base group, and then click Allow for the Remote Access permissions and for the Remote Launch and Remote Activation permissions.
8. Click OK two times to accept the changes.

Remote Access

For remote access to the server via the Internet, we suggest using a Virtual Private Network (VPN) or another secure connection. Access to the database is managed by Windows authentication and SQL Server user management.

We suggest a minimum available bandwidth of 2048 KBit/s.
2 Floating Licenses

The NetHASP dongle can be used with Engineering Base to provide floating (flying) licenses in a network.

NetHASP dongle

The NetHASP dongle can be installed on any computer in the network. All computers accessing the NetHASP dongle must be in the same sub-net with the computer that has the NetHASP dongle installed.

- Installation HASP License Manager
- Installation HASP Device Driver
- Updating a NetHASP Dongle
Installation HASP License Manager

The HASP License Manager has to be installed on the computer with the NetHASP dongle (License Server).

To install the HASP License Manager
1. Insert the CD labelled Engineering Base 3.0.
2. On the Windows Taskbar, click Start, then click Run.
   This opens the Run dialog.
3. In the Open box, type "D:\HASP\LM_Setup_Win32\lmsetup.exe" (where D: is your CD drive).
   This starts the HASP License Manager Installation (depending on your Windows Regional and Language Settings, you are asked to select the language first).
4. In the HASP License Manager Installation dialog, click Next.
5. In the Installation Type dialog, select Service, then click Next.
6. In the Select Program Manager Group dialog, click Next.
7. In the Driver Install dialog, click Yes.
8. In the Start License Manager dialog, click Yes.
9. In the HASP License Manager dialog, click Finish.
10. You might be asked to restart the computer to complete the installation.

For more information see the Help for HASP License manager.
Floating Licenses

Installation HASP Device Driver

The HASP Device Driver has to be installed on every computer where you want to use Engineering Base with flying (floating) licenses.

To install the HASP Device Driver
1. Insert the CD labelled Engineering Base 3.0.
2. On the Windows Taskbar, click Start, then click Run.
   This opens the Run dialog.
3. In the Open box, type "D:\HASP\hdd32\hdd32.exe" (where D: is your CD drive).
   This starts the HASP Device Driver Installation (depending on your Windows Regional and Language Settings, you are asked to select the language first).
4. In the HASP Device Driver Installation dialog, click Next.
5. In the HASP Device Driver Installation Finished dialog, click Finish.
Engineering Base Administrator’s Guide

Updating a NetHASP Dongle

To extend or reduce the number of licenses managed by the NetHASP dongle, the dongle must be updated.

To update a NetHASP dongle
1. Plug the dongle into any computer running Engineering Base.
2. Start Engineering Base.
3. On the Help menu, click Product Keys.
   This opens the Product Keys dialog.
4. Under Dongle Update, click Send e-mail.
   This creates an e-mail with the dongle information and sends this e-mail to AUCOTEC. After you have received the e-mail from AUCOTEC with the update information you can continue.
5. Under Dongle Update, click Apply update.
   This opens the Select File dialog.
6. Select the file with the update information and click OK.
   This updates the dongle.

**NOTE** Updating the NetHASP dongle, via a remote connection to the server is not possible. To avoid removing the dongle from the server computer, you can also use the HASPRUS.EXE program located on the Engineering Base installation CD.
Floating Licenses

Using the Nethasp.ini file

In larger networks, sometimes it is necessary to change the default settings for the NetHASP device driver. These changes are only necessary if you experience problems with the NetHASP dongle.

If you have more than one NetHASP dongle in your network, you must specify the IP address of the computer with the Engineering Base NetHASP dongle.

To specify the IP address of the computer

1. Quit Engineering Base.
2. In the Windows Explorer, expand the Engineering Base program folder (e.g. C:\Program Files\Aucotec\Engineering Base 30\bin).
3. Open the file with the name nethasp.ini.
4. Modify the file as required.
5. Close the file and restart Engineering Base.

Engineering Base should find the NetHASP dongle on the computer with the IP address specified in the file.
3 Optimizing Performance

Besides your computer's hardware, there are some options in Windows, Microsoft Office Visio and SQL Server that influence the overall performance of Engineering Base.

Topics in this chapter:
• Optimizing Windows XP for better Performance
• Optimizing Microsoft Office Visio for better Performance
• Optimizing Microsoft SQL Server for better Performance
• Optimizing Engineering Base for better Performance

Optimizing Windows XP for better Performance

There are some options in Windows, that affect your computer's performance.

To optimize your Windows XP for better performance
1. From the Windows Control Panel, open System.
2. In the System Properties dialog, click the Advanced tab.
3. Under Performance, click Settings.
   This opens the Performance Options dialog.
5. Click OK twice to close the dialogs.
Optimizing Microsoft Office Visio for better Performance

Depending on your computer's performance, you can turn off some features in Visio to make the system faster.

To make working with Microsoft Office Visio faster
1. Quit Engineering Base.
2. From the Windows Start menu, start Microsoft Office Visio.
3. On the Tools menu, click Options.
   This opens the Options dialog.
4. Click the View tab.
5. Under Text quality, click Faster text display.
6. Under Display options, clear the Higher quality shape display check box.
7. Click the General tab.
8. Under Drawing window options, clear the Enable live dynamics check box.
9. Click OK, then quit Microsoft Office Visio.
Optimizing SQL Server for Better Performance

To increase the overall performance of the Microsoft SQL Server, we recommend using different physical hard disks for the data file and for the log file of the SQL Server database. To use different hard disks for the data file and for the log file, you need to select the appropriate folders in the Create a new database wizard of the Engineering Base Database Manager.

You should also limit the maximum memory that is used by the SQL Server to 75% of the RAM.

To limit the maximum memory that is used by the SQL Server

1. On the Windows Start menu, point to Microsoft SQL Server, then click Enterprise Manager.
   This opens the SQL Server Enterprise Manager.
2. Select the SQL Server.
3. On the shortcut menu, click Properties.
   This opens the SQL Server Properties dialog.
4. Click the Memory tab.
5. Move the slider for Maximum (MB) to about 75% of your installed RAM.
6. Click OK and quit the SQL Server Enterprise Manager.

TIP You should also optimize your database regularly. To optimize the database, you can use the Optimize command from the Engineering Base Database Manager.
Optimizing Engineering Base for better Performance

Some rules your users should keep in mind if performance is an issue:

- Empty the recycle bins in Engineering Base from time to time to decrease the size of your database and therefore to save space on your hard disk.
- Disable (stop or remove) any Add-Ins (Auto Device Numbering, Auto Node Numbering) that you don't really need.
- Disable Automatic Wires (un-check the property for the project) if you don't need wiring information constantly updated.
- Use the bus-dot for intersections of connections whenever a potential / signal is distributed to a number of devices and detailed wiring information is not required.
The registry is a database that stores configuration data about the user, installed programs and applications, and specific hardware.

The registry can be edited using the Windows Registry Editor. Please be careful if you make any changes to your registry.

**Important:** Improper Registry settings can have an adverse effect on your computer, even to the point of rendering it useless. Ensure that you BACKUP the Registry before making any changes to it. Better yet, let the system administrator make all changes to the Registry.

Default settings for Engineering Base are located in

HKEY_LOCAL_MACHINEnSOFTWARE\Aucotec\Engineering Base\3.0

User specific settings for Engineering Base are located in

HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0

**Topics in this chapter:**

- Accelerate Preview
- Adding an SQL Server
- Changing the name of the default Application Server
- Changing the name of the default SQL Server
- Changing the name of the default database
- Disabling reopen sheets
- Disabling the start screen
- Setting the picture for the start screen
- Setting the File for the Intro
- Setting the Folder for System Files
Engineering Base Administrator’s Guide

- Setting the Undo Levels
- Setting the default Unit
- Setting the Font
- Setting the Width for the first Column in the Open Dialog

⚠️ You should use the Registry Editor only if you are an advanced user.
Accelerate Preview

On a standalone system you can get better performance for the preview window if you change the ImageFilePath to a local folder.

To change the ImageFilePath
1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_LOCAL_MACHINE\SOFTWARE\Aucotec\Engineering Base\3.0\Server\Files key.
4. Modify the ImageFilePath variable to a local folder (e.g. C:\Documents and Settings\All Users\Application Data\Aucotec\Engineering Base\Tmp).
   The next time you select a sheet, the preview is much faster.

Note This cannot be used if your computer is used as application server for other computers!

Adding an SQL Server

By default, the Open Database dialog only offers the SQL Server that is installed on the computer with the Engineering Base Application Server. You can manually add SQL-Servers from remote computers. However, since this increases network traffic unnecessarily, we do not recommend doing this in a larger network.

To add a SQL Server
1. Ensure you have administrator rights.
2. Start regedt32.
3. In HKEY_LOCAL_MACHINE on the local computer, open SOFTWARE\Aucotec\Engineering Base\3.0\Server\Database.
4. Double click ServerNameList.
5. Add the remote SQL Server to the list.
Changing the name of the default Application Server

To change the name of the default Application Server

1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Database key.
4. Select the Application Server value.
5. On the shortcut menu, click Modify.
6. In the Value data box, type the name of the Application Server (Example: SERVERNAME)
7. Click OK to save your changes.
8. Start Engineering Base.

Engineering Base uses the application server specified in the Application Server value.
Changing the name of the default SQL Server

To change the name of the default SQL Server
1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Database key.
4. Select the ServerName value.
5. On the shortcut menu, click Modify.
6. In the Value data box, type the name of the server.
7. Click OK to save your changes.
8. Start Engineering Base.

   Engineering Base opens the server defined in the ServerName value.
Changing the name of the default database

To change the name of the default database

1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Database key.
4. Select the DatabaseName value.
5. On the shortcut menu, click Modify.
6. In the Value data box, type the name of the database
7. Click OK to save your changes.
8. Start Engineering Base.

Engineering Base opens the database defined in the Name value.
Disabling reopen sheets

Reopen sheets automatically opens the sheets that were open in Visio when you closed Engineering Base. Use Registry Editor to disable this feature.

To disable reopen sheets
1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Settings key.
4. Select the Reopen Plans value.
5. On the shortcut menu, click Modify.
6. In the Value Data box, type 0 to disable reopen plans.
7. Click OK.
8. Start Engineering Base.
   Engineering Base will no longer automatically reopen the sheets in Visio.

Disabling the start screen

The start screen is visible while Engineering Base loads.

To disable the start screen
1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_LOCAL_MACHINE\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Settings key.
4. Create a new DWORD value No Start Picture and set the value to 1.
5. Start Engineering Base.
   Engineering Base will no longer show the start screen.
Engineering Base Administrator's Guide

Setting the picture for the start screen

To define the picture for the start screen
1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Files key.
4. Create a new String value Start Picture Path and set the value to the path and file used for your start screen.
5. Start Engineering Base.
   Engineering Base will now show the new picture for the start screen.
   You can use BMP, GIF, JPG, PCX, TARGA and TIFF files for your start screen picture.

Setting the File for the Intro

To define the file used for the intro
1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Files key.
4. Create a new String value Intro Path and set the value to the path and file used for your intro.
5. Start Engineering Base.
   Engineering Base will now show the new intro.

You can use any executable file for your intro.
Setting the Folder for System Files

While working with Engineering Base, some files are copied to the hard disk of your computer. Normally these files are copied to the Documents and Settings folder for the user. In some networks, the available space for this directory is limited and it is necessary to use another folder.

To define the folder for system files

1. Quit Engineering Base.
2. Start the Registry Editor.
3. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client key.
4. Create a new String value RuntimeRootPath and set the value to the path you want to use (e.g. c:\temp\Engineering Base).
5. Start Engineering Base.
Setting the Number of Undo Levels

By default, the number of undo levels is set to 10. If required, you can change this setting by modifying the registry.

To define the number of undo levels
1. Quit Engineering Base.
2. Start Registry Editor.
3. Look for the HKEY_LOCAL_MACHINE\SOFTWARE\Aucotec\Engineering Base\3.0\Server\Settings key.
4. Create a new DWORD value CBUndoStackSize and set the value to the required number of levels.
5. Start Engineering Base.

Using more undo levels, requires more resources on your local computer and server. Eventually data is temporarily saved from the memory to the hard-disk and system performance might decrease significantly.
**Windows Registry Settings**

### Setting the default Unit

Depending on the measurement system selected in the Regional and Language Options on your computer, numbers typed into the boxes for **Depth**, **Heigt**, and **Width**, are interpreted as mm (Metric) or inches (U.S.). Editing the registry allows you to define another unit as the default unit.

**To define the default unit**

1. Quit *Engineering Base*.
2. Start *Registry Editor*.
3. Look for the `HKEY_LOCAL_MACHINE\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Settings` key.
4. Modify the `DefaultUnit` to set the value data to the required unit (e.g. cm).
5. Start *Engineering Base*.

### Setting the Font

The font used for the Navigation Pane, List Pane, Worksheets, and Open dialogs can be changed.

**To change the font**

1. Quit *Engineering Base*.
2. Start *Registry Editor*.
3. Look for the `HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Settings` key.
4. Create a new String value `FontName` and in Value data, type the name of the font.
5. Create a new DWORD value `FontHeight` and in Value data, type the size of the font.
Setting the Width for the first Column in the Open Dialog

To define the width for the first column in the Open dialog

1. Start Registry Editor.

2. Look for the HKEY_CURRENT_USER\SOFTWARE\Aucotec\Engineering Base\3.0\Client\Settings key.

3. Create a new DWORD value MaskAttributeColWidth and set the value to the width.

   The next time you open the dialog for an object, the width for the first column will be modified.